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Chapter 1: Introduction

Chapter 1: Introduction

Welcome to xMatters (alarmpoint) for HP Service Manager Change Management. This document describes how to
install and configure the xMatters (alarmpoint) for HP Service Manager Change Management software integration.
The intended audience for this document is experienced consultants, system administrators and other technical
readers.

1.1 Summary

xMatters is an interactive alerting application, designed to capture and enrich important events, to route those events
to the right person on any communication device, and to give that person the ability to solve, escalate, or enlist
others to resolve the events remotely.

xMatters allows you to take critical business information and contact the right people via voice phone, SMS, two-
way pagers, instant message, and email.

Through integration modules, xMatters can become the voice and interface of an automation engine or intelligent
application (the Management System, such as HP Service Manager Change Management). When HP Service
Manager detects something that requires attention, xMatters places phone calls, sends pages, messages, or emails to
the appropriate personnel, vendors or customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with HP
Service Manager Change Management. Responses are executed immediately on HP Service Manager, enabling
remote resolution of the event.

This integration supports change request notifications (from HP Service Manager to xMatters). It also supports
inbound actions (from xMatters to HP Service Manager).

You will need to modify this configuration to suit your particular business requirements and adjust it to suit your
expected loads. For example, the default integration features automatic status annotations to the original event; in a
high-volume production system, this can significantly affect performance. Consider your expected volume of
injected events and your server capacity when designing your own integration with xMatters.

1.1.1 Benefits

With the xMatters integration, the appropriate technician can be notified directly via voice, email, pager,
BlackBerry, or other device. Information about the failure will be presented to the event resolver and decisions can
be made in real-time.

Once a response is selected on the recipient’s remote device, xMatters will update the HP Service Manager change
request in real-time. The benefit is that this process is immediate — significantly faster than the time required for staff
to notice the failures or malfunctions, determine who is on call, and manually notify the right person. In addition,
the ability to take simple actions on the event from any device gives the event resolver a quick way to deal with
many issues and communicate to other team members the current state of the event.

During the process, every notification, response, and action is logged in xMatters. In addition, xMatters
automatically annotates the original change request with status information.

The xMatters product features a self-service web user interface to allow accurate assignment of responsible personnel
for each job. xMatters also includes an optional enhanced Subscription panel that allows both managed and self-
subscription to HP Service Manager events. This Subscription panel queries the HP Service Manager server directly
in real time to retrieve lists of important settings and criteria, removing the need to create and maintain these lists.
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1.1.2 xMatters mobile access

This version of xMatters also includes the xMatters mobile access application. With the mobile access component, the
appropriate technician can create, view, and update HP Service Manager messages directly via a mobile device’s web
browser. Information about HP Service Manager events can be displayed on the mobile device and updated in real-time.

The benefit is that this process is immediate and may be done remotely — providing users with an efficient method of
handling HP Service Manager events from any mobile device. In addition, the integration can be updated to notify xMatters
Users on their mobile devices with a link to the mobile view of the event, allowing the user to update the event remotely.

1.1.3 Information Workflow

The following diagram illustrates a standard workflow in a change request management system, and how information from
the management system is passed into the xMatters (alarmpoint) engine:

Change Management System

SLAS

Coordinator Priority MEonsara Phase
Assignment Upgrade i Completed
User Change Updated or Implemented
Change Approval
Created Required
Subscribed
Change Approval Response Information Closure

Information Information Information Information

xMatters (alarmpoint) engine

SEVPUW:N SN

Targeted Subscription
Notifications Notifications

1.1.4 Integration architecture
The software components in this integration include:

e xMatters (alarmpoint) engine and the mobile access component
e HP Service Manager Change Management

e xMatters integration agent

The following diagram illustrates the software processes used by this integration:

Chapter 1: Introduction | 2



xMatters (alarmpoint) for HP Service Manager Change Management

XMatters (alarmpoint) for HP Service Manager
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HP Service
Manager -
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Whenever HP Service Manager detects a problem, it triggers the following steps (for a description of what will cause an
event to be injected into xMatters, see "Event injection triggers", below):

Web Services

1. HP Service Manager sends the event details to the xMatters integration agent via HTTP POST.
2. The integration agent forwards the event details to xMatters via web services.

3. The response returns to the integration agent.

4. The integration agent sends the response to HP Service Manager via web services.

User and Group synchronization process

As illustrated in the diagram, event injection for this integration is handled via the xMatters integration agent. User and
Group synchronization, however, is handled via direct web service calls between xMatters and HP Service Manager. For the
User and Group synchronization process to work, the Web Services User must be properly configured, as described in
"Adding the Web Service User" on page 19.

xMatters mobile access integration architecture

The following diagram illustrates the software processes used by the mobile access component of the integration:

xMatters mobile access for HP Service Manager

1 E 2 3
\ - xMatters -
. mobile access
- - = -
Mabile 6 5 xMatters 4 HP
Device Integration agent Service Manager
xM.atters
web server
- /
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The following steps occur for each action initiated by a mobile user (the steps correspond to the numbers in the above
diagram):

A User sends a request from a mobile Device to xMatters mobile access.

The mobile access component processes the request and relays instructions to the xMatters integration agent.
The integration agent communicates with HP Service Manager via the HP Service Manager web services APL.
The response is sent back to the integration agent via web services.

The integration agent processes the response and sends it to the mobile access component.

A e

Rendered results are sent back to the mobile Device.

Event injection triggers

The following is a summary of the circumstances under which HP Service Manager will inject an event into xMatters for
notification. Note that this is the default, out-of-box behavior, and may be configured differently for some deployments.

e An event will be injected into xMatters whenever a new change request is created with a Priority of "Critical" or
"High".

e An event will be injected into xMatters whenever an existing change request with a Priority of "Critical" or "High" is
modified by upgrading the Priority, changing the Phase, or modifying the Assignee.

These events are untargeted events, used for subscriptions only.

An event will also be injected into xMatters when the Phase is changed to one that requires approval. At this point, the event
will be targeted to the approvers that are defined in the approval associated to the Change Phase in the Approvals section of
HP Service Manager; this is configurable within the HP Service Manager Client, and is specific to each customer's
implementation.

Note: The only time a targeted event is injected into xMatters is for approvals; all other events are untargeted.

1.2 System Requirements

The following products must be installed and operating correctly prior to integration:

e xMatters (alarmpoint) engine 4.1 (patch 003 or later) with a valid xMatters mobile access license.
e xMatters integration agent 4.1 (patch 001 or later)

e xMatters Developer IDE

e HP Service Manager Change Management 9.2

1.2.1 Operating Systems
The following operating systems are supported by this integration:

e Microsoft Windows 2003 (validated)
e Microsoft Windows 2008

1.3 Conventions and Terminology

This section describes how styles are used in the document, and provides a list of definitions.

1.3.1 Conventions

Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:
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o text that must be typed into the computer
e directory and file names

e code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.
The xMatters installation folder is referred to throughout the documentation as <xMHOME>.
e On Windows systems, the default is C:\Program Files\AlarmPointSystems\AlarmPoint\
e On Unix systems, the default is /opt/alarmpointsystems/alarmpoint/
The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

e On Windows systems, the default is C:\Program Files\AlarmPointSystems\IntegrationAgent\
e On Unix systems, the default is /opt/alarmpointsystems/integrationagent

1.3.2 Terminology

The following terms are used through the xMatters documentation.

Documentation terminology

Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology, but can also collectively be called events.

Management system A management system is any sort of monitoring or managing software that watches for events, and
with which xMatters can combine; i.e., a synonym for HP Service Manager.

Device The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,
BlackBerry, etc.

User In xMatters, people who can receive notifications are called "Users". Each person in the xMatters
system is defined by a set of User details, including ID number, user name, login password, and so
on.

Group Groups are used to collect and organize Users and Devices into notification schedules. For a

complete explanation of Groups in xMatters, see the xMatters (alarmpoint) engine user guide.
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Chapter 2: Installation and Configuration

This chapter provides information about installing the xMatters (alarmpoint) for HP Service Manager Change Management
integration. This chapter also contains complete instructions on how to configure xMatters, HP Service Manager, and the
integration components.

The instructions in this chapter do not include information on how to install xMatters (alarmpoint) engine, the xMatters
integration agent, or HP Service Manager Change Management. These components must be installed according to their
related documentation, and operating properly before you can proceed with the integration.

Note that in most cases, the xMatters integration agent must be installed on the same server as HP Service Manager.

Note: For more information about installing xMatters (alarmpoint) engine and other xMatters products, refer to the
xMatters web site at http:///www.xmatters.com.

2.1 Installing integration components
The following table describes some of the notable components in the integration archive file:

Integration components

Component Name Description

com.alarmpoint.servicemanager.cm.jar  Contains the Web Services Library, which is used in the xMatters Action
Scripts to inject responses back to HP Service Manager, and used by the
Subscription Panel to retrieve the available Categories, Subcategories, Problem
Types and Product Types.

SMCMSubscriptionForm.jsp Custom Subscription JSP that allows users to subscribe to Events associated
with specific criteria (category, urgency, etc.).

AlarmPointSyncConfig.xml Contains all the Groups, Teams, Users, Devices and Coverage value mappings
used when synchronizing HP Service Manager operators and assignments with
xMatters Users and Groups.

AlarmPointSyncList.xml Contains a list of all of the HP Service Manager operators and assignments to
either include or exclude from synchronization with xMatters.

AlarmPointForms.sc HP Service Manager unload files used to import all the custom xMatters records
AlarmPointScriptLibrary.sc and tables.

AlarmPointTriggers.sc

AlarmPointUnload.sc

AlarmPointWebService.sc

AP-HP-ServiceManager-CM.aps Contains the xMatters Action Scripts required for the integration.

hpsmcm.js Contains the Javascript code to support the calls from HP Service Manager to
the integration agent when injecting events into xMatters.

hpsmem.xml Contains the configuration information for the integration agent.

2.1.1 Installing the web services library

To enable web service calls between xMatters and HP Service Manager, you must copy the JAR file from the 1ib folder in
the extracted integration archive into the web server library folder, and into the xMatters mobile access folder.
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Note: The "AlarmPointWebService" Java Script, imported as part of the AlarmPointScriptLibrary.sc, is a generated file
with customized modifications. Do not attempt to regenerate this file, and do not alter it in any way.

Source file:

xM-HP-ServiceManager-CM 2 3 1\components\alarmpoint\lib\com.alarmpoint.servicemanager.cm.jar

Web server destination directory:

<xXMHOME>\webserver\webapps\cocoon\WEB-INF\1lib

xMatters mobile access destination directory:

<xMHOME>\webserver\webapps\mobilegateway\WEB-INF\1lib

Note: If you have installed more than one web server, copy the JAR file into the destination directories on each one.

2.1.2 Installing the integration service

To enable the HP Service Manager integration service, you must copy the folder containing the integration agentfiles into the
xMatters integration services folder and modify the hpsmem.js and IAConfig.xml files. If you have more than one
integration agent providing the HP Service Manager service, repeat the following steps for each one.

To install the integration service:
1. Copy the following folder to the <TAHOME>\integrationservices folder:
xM-HP-ServiceManager-CM 2 3 I1\components\alarmpoint-integration-agent\hpsmcm
2. Open the <IAHOME>\conf\IAConfig.xml file and add the following line to the “service-configs” section:
<path>hpsmcm/hpsmem. xml</path>
3. Open the <IAHOME>\integrationservices\hpsmcm\hpsmcm.js file and modify the following fields:

1. smUrl: replace “localhost” with your HP Service Manager server’s IP Address.e

2. calloutAnnotateUser and calloutAnnotatePass: replace with user credentials for an HP Service Manager user
with SOAP API, xMatters and HP Service Manager Administration capabilities/permissions. This user (configured
in "Adding capabilities to users" on page 12) will be used to update the Journal Activities with phone callout
annotations.

4. Restart the integration agent.
e On Windows, the integration agent runs as a Windows Service; on Unix, it runs as a Unix daemon.

2.1.3 Installing the subscription files

To use the optional subscription panel, you must copy the JSP files into the xMatters installation folder. If you have more
than one web server, repeat the following steps for each one.

To install the JSP files:

1. Copy the xM-HP-ServiceManager-CM_2 3 1\components\alarmpoint\sub-panel\hpsmcm folder from the
extracted integration archive into <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription.

2. Restart the web server.

2.1.4 Installing the mobile access component files

To enable the mobile access component, you must copy the folder containing the JSP files into the xMatters mobile access
folder. If you have more than one web server, copy the JSP files into the indicated folder on each web server.
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To install the mobile access component files:

1. Copy the xM-HP-ServiceManager-CM 2 3 1\components\alarmpoint\mobilegateway\hpsmcm folder from the
extracted integration archive to the <xMHOME>\webserver\webapps\mobilegateway\jsp folder on the xMatters
server.

2. If your deployment is running the xMatters (alarmpoint) engine version 4.1 patch 006, you can update the xMatters
mobile access to the latest images and styles:

e Copy all of the JSP files in the xM-HP-ServiceManager-CM 2 3
1\components\alarmpoint\mobilegateway\ folder to the
<XMHOME>\webserver\webapps\mobilegateway\jsp folder on the xMatters server.

e Copy the CSS file from the xM-HP-ServiceManager—-CM 2 3 1\components\alarmpoint\mobilegateway\
folder to the <xMHOME>\webserver\webapps\mobilegateway\css folder on the xMatters server.

2.1.5 Installing voice files

These files must be installed into any xMatters deployment running a voice Device Engine. For more information, refer to the
xMatters (alarmpoint) engine installation and administration guide.

To install the voice files:

1. Copy all of the files in the xM-HP-ServiceManager-CM 2 3 1\components\alarmpoint\vox\english folder from

the extracted integration archive to the following node installs folder:

<xXMHOME>\node\phone-engine\Datastore\domains\common\recordings\english\phrases

Note: This integration provides a complete set of English voice files.

2.1.6 Installing the synchronization configuration files

The AlarmPointSyncConfig.xml and AlarmPointSyncList.xml files contain the configuration information for
synchronizing Users, Groups, Devices and Coverages from HP Service Manager into xMatters.

Note that the synchronization process and all its files are identical for both the HP Service Manager Change Management and
the HP Service Manager Incident Management integrations; if you have already installed the HP Service Manager Incident
Management integration (version 2.3.1), you can skip this step.

To install the synchronization configuration files:

Copy the files in the xM-HP-ServiceManager-CM 2 3 1\components\servicemanager\config\ folder from the
extracted integration archive to <SMHOME>.

Note: [f these files are installed to a different location, you must modify the AlarmPointConfig script library within HP
Service Manager.

2.2 Configuring HP Service Manager

Configuring HP Service Manager to combine with xMatters requires the following steps:
= Import the xMatters tables and records.
s Modify the HP Service Manager triggers.
s Modify the AlarmPointConfig script.
= Add the SOAP API and xMatters capabilities to HP Service Manager User for xMatters web service calls.

» Update the IM.template.update and IM.update.incident forms to allow web service calls to update change requests.
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Expose the problem.type and product.type tables for web service calls.

Remove the invalid data from HP Service Manager Categories.
Add the syncContact call to the createUser 2 Wizard.
= Enable Resolve for Web Services.

2.2.1 Importing xMatters tables, records, and web services

The xMatters tables, records, and web services are used to inject change requests to xMatters for notification, and required by
the HP Service Manager database for the integration.

The .sc files described in this section are shared between both HP Service Manager integrations; if you have already installed
the HP Service Manager Incident Management integration (version 2.3.1), you should skip this step.

To import the tables, records, and web services:

Log in to the HP Service Manager Client Console.

Open the Administration perspective.

In the System Navigator, open the Tailoring folder, and then double-click the Database Manager object.
In the drop-down menu in the upper-right comer of the main object window, select Import/Load.

Click the folder icon beside the File Name field.

Select the first . sc file in the xM-HP-ServiceManager-CM 2 3 1\components\servicemanager\imports\
directory.

7. Click Open.
8. Click Load FG.

A e

Repeat the above steps for each of the remaining . sc files in the imports directory.

Note that when importing AlarmPointForms.sc, the error illustrated in the following figure may occur:

Ey— 7. =8

(1) 10 records loaded inta displavoption file from external file: Z:\Inteqgrations\HP-3M-CIMY2, 234P-HP-ServiceManager-_Micompaonent s servicemanageriimpo. .. ;I
orms, 50
& display screen named "alarmpoint.whoisonduty® Found. Campile aborted.
[ TOR display screen named "alarmpoint.whoisonduty® Found. Compile aborted.
Mo display screen named "alarmpoint, syncreport” Found, Compile aborted,
o display screen named "alarmpoint. syncreport” Found. Compile aborted.
€3 1o display screen named "alarmpoint. syncreport” Found. Compile aborted.
ﬂ Mo displ
£y Loading displayoption file Fram external file: Z:1IntegrationsiHP-3M-CM 2, 21 AP-HP-Ser viceManager-CMi componentst servicemanager importsi alarmPaoint. .
(1) 0 records from Z:\Integrations\HP-3M-CMV2, 24 AP -HP-ServiceManager-CMicomponentst servicemanagerimportsi AlarmPointForms, sc updated in alarmpoi, ..

r

late screen named "alarmpoint. quickn ge" Found, Compile aborted,

You can safely ignore this error message.

Service Manager Unload scripts

This integration includes a set of HP Service Manager unload scripts intended to help with the maintenance of the
integration. The unload scripts are:

e AlarmPoint Forms: This script unloads all the capability words, dbdict definitions, displayoptions, displayscreens,
formats, globallists, menus and scripts associated with the integration.

e AlarmPoint Integration: This unload script is a combination of the Forms, ScriptLibrary, Triggers, Unload and Web
Services unload scripts.

e AlarmPoint Purge: This unload script is similar to Integration but instead of an unload this script performs a purge
e AlarmPoint ScriptLibrary: This unload script unloads the xMatters Java Scripts found in Script Library
e AlarmPoint Triggers: This unload script unloads the xMatters triggers associated with the integration.
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e AlarmPoint Unload: This unload script unloads the unload scripts.

e AlarmPoint Web Services: This unload script unloads the External Access Definitions needed as part of the integration.
Note that this does not unload a comprehensive list of the External Access Definitions that are required; it is an unload
of the definitions which are unique to the integration and created to support the integration. Definitions such as
IncidentManagement, which are updated to support the integration, must be managed manually.

2.2.2 Modifying the HP Service Manager triggers

Importing the AlarmPointTriggers. sc file loads all of the triggers for both of the xMatters for HP Service Manager
integrations. If you want only the HP Service Manager Change Management integration (i.e., you are not installing the HP
Service Manager Incident Management integration), you should delete the triggers specific to the other integration.

To delete the triggers:

1. In the HP Service Manager Database Manager's Form field, type triggers, and then press Enter.
2. In the Trigger Name field, type alarmpoint and then press Enter.
3. Locate and delete the following triggers:

e alarmpoint.after.add.probsummary

e alarmpoint.after.update.probsummary

2.2.3 Modifying the AlarmPointConfig script

The AlarmPointConfig script contains configuration information for web services, data synchronizations, and other parameters
as described in the table below. This section describes how to modify the configuration script to allow HP Service Manager
to inject change requests to xMatters through web services.

Note: The configuration files described in this section are shared between both HP Service Manager integrations; if you
have already installed the HP Service Manager Incident Management integration (version 2.3.1), you can skip this
step.

To modify the AlarmPointConfig script:

1. In HP Service Manager System Navigator, open the Tailoring folder, and then double-click the Script Library object.
2. In the Name field type AlarmPointConfig, click Search.

3. Modify the variables in the following table to suit the configuration of your integration.

4. Click Save, Compile, and then Execute.

e If HP Service Manager returns any errors after you click Compile, ensure that you have updated the file correctly.

AlarmPointConfig script variables

Variable Name Value

web_service_url The URL of the xMatters web service; for example:

"http://localhost:8888/api/services/AlarmPointWebService";

web_service_user The user name of the xMatters Web Service User (as configured in "Adding
the Web Service User" on page 19). Best practices suggest that the User name
be related to the purpose; e.g., "hpsm-xmwsu".

web_service_password The password of the xMatters Web Service User (as configured in "Adding
the Web Service User" on page 19).

alarmpoint_servicemanager_im_domain = The name of the xMatters Event Domain for notifications.
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Variable Name Value

default_alarmpoint_admin_group The target name of the recipient (Group or User) in xMatters where
synchronization error notifications are sent. This Group is created in
"Creating a fail-safe Group" on page 26.

Note: If a Group has a synchronization error and that Group has a supervisor,
the Group supervisor will be notified instead of this recipient.

send_sync_error_notifications If true, sends notifications to the default administration Group created in
"Creating an Admin Group" on page 26 (or the Group Supervisor) when a
record fails to synchronize with xMatters.

alarmpoint_servicemanager_sync_domain The xMatters Event Domain for Service Manager. The value initializes the
variable using an existing variable value, and should not include quotes.

Note: If you are installing ONLY the HP Service Manager Change
Management integration, change the variable name to:
alarmpoint_servicemanager cm_domain

sm_home The location of the HP Service Manager installation; for example:

"C:\\Program Files (x86)\\HP\\Service Manager 9.20\\Server\\"

config_file The location of the AlarmPointSyncConfig.xml; for example:

sm_home + "AlarmPointSyncConfig.xml"

synclist_file The location of the AlarmPointSyncList.xml; for example:

sm_home + "AlarmPointSyncList.xml"

ia_url The URL of the integration agent HTTP listener; for example,
http://localhost:2010/agent

Note: If the integration agent is installed on the same computer as HP Service
Manager, you do not need to modify this parameter.

alarmpoint_company Name of the Company within xMatters; the default value is “Default
Company”.

sync_voice If true, voice Devices will be synchronized; the default is true.

detailedSyncLogging If true, displays filtering information when performing a synchronization;

default is true.

detailEventLogging If true, displays the APXML being sent to xMatters; default is false.

sync_cm3groups If true, synchronize HP Service Manager Change groups when performing a
synchronization; default is true.

sync_assignmentGroups If true, synchronize HP Service Manager Assignment groups; default is true.

assignmentGroupSuffix Specifies the string to add to the end of HP Service Manager Assignment
group names when synchronizing.

Note: This suffix prevents possible name collisions between Assignment and
Change groups, which can have the same name in HP Service Manager, but
must have unique names in xMatters.
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Variable Name Value

changeGroupSuffix Specifies the string to add to the end of HP Service Manager Change group
names when synchronizing. (See note above for more information)

2.2.4 Adding capabilities to users

The integration requires all users who are going to respond to notifications through xMatters to have both the "SOAP API"
and "AlarmPoint" capabilities in addition to the appropriate xMatters configuration as described in "Configuring Users" on
page 18. These users can update and annotate HP Service Manager change requests from xMatters through web service calls.

To add the required capabilities to a user:
1. In the HP Service Manager System Navigator pane, expand the System Administration > Ongoing Maintenance
folders, and then double-click the Operators item.

2. In the Login Name field, type the login name of the user to whom you want to give response capabilities, and then
click Search.

e The default configuration of the xMatters Action Scripts uses the default HP Service Manager user “falcon” to
make web service calls; if you want to use a different user, you must update the Action Scripts accordingly. For
more information, see “Configuration Variable Reference” on page 54.

3. Select the Startup tab.
4. Under Execute Capabilities, if not already listed, add SOAP API and AlarmPoint.
5. Click Save.

xMatters may now use web service calls to connect to this HP Service Manager User.

2.2.5 Exposing additional fields for existing web services

For the mobile access component to access tables in HP Service Manager, you must expose the sub-tables in the extaccess
table.

To expose a Service Manager table for Web Services:

1. In HP Service Manager System Navigator, open the Tailoring folder, and then double-click the Web Services object.
2. Double-click WSDL Configuration.

3. On the External Access Definition form, enter the name of the table you want to expose within the Name field, and
then click Search.

o If the form is automatically populated, ensure the Object Name matches the name used to construct SOAP
Actions. If the Object Name does not match, modify it, or change the xMatters Configuration Rules.

e Confirm that the automatically populated table contains the values described in "xMatters mobile access exposed
table details", below.

o If the form is not automatically populated, continue with the following steps to create the table.

4. Enter the following information into the form:

Field Value

Service Name Name of the service

Name Name of the table you want to expose

Object Name Name to use when constructing the SOAP Action
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Field Value

Field Name of the field in the table.

Caption Name to use for the element in the web service instance element; if left blank, the Field Name is
used by default.

Type Used to convert the record value to or from an XML value. (This is not required for the xMatters

mobile access.)

7. Click Save, and then click OK.

XMatters mobile access exposed table details

The following lists the tables and fields that must be exposed for the default xMatters mobile access integration.

Change Management table

e Service Name: ChangeManagement

e Name: cm3r

e Object Name: Change

Confirm that all of the following fields exist:

Field Caption Type
close,closing.comments ClosingComments

close,completion.code ClosureCode

description.structure,backout.method BackoutMethod

description.structure,description Description

description.structure,justification Overall Assessment

header,agreement.id SLAAgreementID IntType
header,approval.status ApprovalStatus

header,assigned.to AssignedTo

header,backout.duration BackoutDuration DurationType
header,brief.description Title

header,category Category

header,close.time CloseTime DateTimeType
header,company Company

header,coord.phone CoordinatorPhone

header,coordinator ChangeCoordinator
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Field Caption Type
header,current.phase Phase

header,date.entered DateEntered DateTimeType
header,foreign.id ExtProjectRef

header,number ChangelD

header,open Open BooleanType
header,planned.end PlannedEnd DateTimeType
header,planned.start PlannedStart DateTimeType
header,priority.code Priority

header,reason Reason

header,requested.by InitiatedBy

header,risk.assessment Risk Assessment

header,status Status

header,subcategory Subcategory

header,type.level2 RFCType2

intial.impact Impact StringType
middle,actual.cost ActualCost

middle,actual.outage.end ActualOutageEnd DateTimeType
middle,actual.outage.start ActualOutageStart DateTimeType
middle,actual.price ActualPrice

middle,assets Assets

middle,down.end ScheduledDowntimeEnd DateTimeType
middle,down.start ScheduledDowntimeStart DateTimeType
middle,estimate.description EstimateDescription

middle,estimate.price EstimatePrice StringType
middle,location Location

middle,Jogical.name Configurationltem

middle,misc.arrayl MiscArray

middle,misc.array2 MiscArray?2

middle,misc.array3 MiscArray3

middle,miscl Miscl

middle,misc10 Misc10
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Field Caption Type
middle,misc2 Misc2

middle,misc3 Misc3

middle,misc4 Misc4

middle,misc5 Misc5

middle,misc6 Misc6

middle,misc7 Misc7

middle,misc8 Misc8

middle,misc9 Misc9

middle,sched.outage.end ScheduledOutageEnd DateTimeType
middle, sched.outage.start ScheduledOutageStart DateTimeType
severity Urgency StringType
requestedDate RequestedEndDate DateTimeType
releaseCandidate ReleaseCandidate BooleanType
location.full.name Location StringType
emergency Emergency BooleanType
closureComments ClosureComments

affected.item Service

approvalComments ApprovalComments

header,assign.dept AssignmentGroup

release.type ReleaseType

2.2.6 Add the syncContact call to the createUser 2 Wizard

The AlarmPointUser.syncContact call must be added to the createUser 2 Wizard to enable synchronization of users upon their
creation.

Note that while HP Service Manager’s User Quick Add Utility has space for both first and last names, the xMatters
synchronization parses the first word (up to the first space) within the Full Name field as the first name, and adds any
remaining words to the last name. For example, if a user was added in HP Service Manager with a first name of “One Two”
and a last name of “Three Four”, xMatters would parse the entry as first name “One” and last name “Two Three Four”.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To add the syncContact call:

1. In the HP Service Manager System Navigator pane, in the Tailoring folder, double-click Wizards.
2. In the Wizard Name field, type createUser 2 (case sensitive), and then click Search.
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3. Click the Actions tab, and then click the Javascript tab.
4. Add the following line to the Javascript:

system.library.AlarmPointUser.syncContact (vars.$contactname) ;
5. Click Save.

Now when a user is created in HP Service Manager using the createUser 2 Wizard, they will be automatically synchronized
with xMatters.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different Users.

2.2.7 Adding the syncContact call to the Process record

For the contact.do.save call to properly synchronize user information with xMatters, the AlarmPointUser.syncUser call must
also be added to the Process record.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To add the syncContact call:

1. In HP Service Manager, click Menu Navigation > Tailoring > Database Manager.

2. In the Table field, type Process, and then click the Search button.

3. On the Process Definition form, in the Process Name field, type contacts.do.save, and then click the Search button.
4. Click the Final JavaScript tab.

5. Add the following line to the JavaScript:

system.library.AlarmPointUser.syncUser (record, oldrecord);

6. Click Save.

2.3 Configuring xMatters

The following sections explain how to configure your xMatters deployment to combine with HP Service Manager.

2.3.1 Importing the script package

This integration includes a set of customized Action Scripts specific to HP Service Manager that must be imported into the
xMatters scripts.

Note:  This step requires the xMatters Developer IDE. For installation instructions and more information about scripting
in xMatters, refer to the xMatters Online Developer's Guide.

To import the xMatters Script Package:

1. Launch the IDE, and then configure the database connection.
2. Click Workspace > Import.

Select the xM-HP-ServiceManager-CM 2 3 1\components\alarmpoint\scripts\AP-HP-ServiceManager-
CM. aps file extracted from the integration zip file, click Open., and then click OK.

4. When the script has finished importing, click OK.

5. In the Workspace pane, expand the HP Service Manager Change Management (BUSINESS) > PRODUCTION >
PROCESS folder, and double-click the initial script.
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6. In the initial script, locate the $main.xMatters URL variable to specify the address of the xMatters web server.
e This enables the HTML response options.

7. Locate the following variables and replace the value in quotes with your default HP Service Manager login credentials:
o $main.servicemanager username = "falcon"
e $main.servicemanager password = ""

8. Right-click the HP Service Manager Change Management (BUSINESS) folder, and then select Validate.

9. Right-click the folder again, and then select Check In.

10. In the Create Script Package dialog box, click Create.

11. In the Check In dialog box, click Clese.

2.3.2 Configuring the Event Domain

By default this integration is set up to use an Event Domain of “hp_sm change”; it is strongly recommended that you use
this Event Domain name. For the integration to be successful, the Event Domain name must match the AGENT CLIENT ID
constant defined in the integration agent javascript file (hpsmcm. js).

The xMatters (alarmpoint) engine web server must be running to perform this portion of the integration.

To define an Event Domain:

1. Sign on to xMatters as a Company Administrator, and click the Developer tab.
2. In the Developer menu on the left side of the screen, click Event Domains.
3. On the Event Domains page, click Add New.
4. Enter the following information into the form:
e Name: hp sm_change
o Description: HP Service Manager Integration
e Script Package: HP Service Manager Change Management
5. Click Save.

Defining an Integration Service

The mobile access component for this integration uses a default integration service of “hpsmcm”; it is strongly recommended
that you use this default integration service name. For the installation to be successful, the integration service name must
match the name specified in the AGENT CLIENT ID variable in the hpsmcm. js file and the hpsmem.xml file installed on
the integration agent.

To define an Integration Service:

1. In xMatters, on the Event Domains page, click the hp_sm_change Event Domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

e Name: hpsmcm

e Description: HP Service Manager Integration Service

e Path: hpsmem/menu.jsp
4. Click Save.

2.3.3 Defining Custom Fields

This integration uses custom fields defined in xMatters to obtain authentication credentials for submitting notification
responses and annotations to HP Service Manager. These custom fields enable the response option list to be displayed on
notifications.
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The mobile access component also uses these custom fields to obtain authentication credentials for logging into HP Service
Manager. These custom fields are optional for the mobile access component as a login page will be displayed if the custom
fields are not provided.

By default, the custom fields are “HP SM Login” and “HP SM Password”; it is strongly recommended that you use these
default field names.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To define the custom fields:

1. In xMatters, click the Admin tab, and then, in the Administration menu on the left side of the screen, click Custom
Fields.
2. Click Add New, and then enter the following information into the form:
e Field Name: HP SM Login

e Type: Text
3. Click Save.
4. Click Add New, and then enter the following information into the form:

o Field Name: HP SM Password
e Type: Password
5. Click Save.

Note: For more information about custom fields, see the xMatters (alarmpoint) engine installation and administration
guide.

2.3.4 Configuring Users

Each xMatters User that will be notified and respond to notifications must be configured to allow xMatters to communicate
with HP Service Manager as that User. Note that each User must also be configured in HP Service Manager, as described in
"Adding capabilities to users" on page 12.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To configure a User for mobile access to HP Service Manager:

1. In xMatters, click the Users tab.
2. Use the Find Users page to locate the User you want to configure and view their details.
3. On the Details for User page, select the Has Mobile Access check box.

e If you defined the custom fields, enter their HP Service Manager login credentials in the HP SM Login and HP
SM Password custom fields.

4. In the Common Tasks pane, click User Devices.
5. Verify that an appropriate Device exists and that it is enabled.
6. Click Save.

Note: If you have no Users in the system, you can use the default demonstration User, "bsmith". If this User does not exist,
create a User with the User ID “bsmith”, and add a virtual text phone Device. Ensure that the User also has access
to the mobile access component. For more information and instructions on how to perform these tasks, refer to the
xMatters (alarmpoint) engine user guide.
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2.3.5 Adding the Web Service User

This integration requires a Web Service User for the HP Service Manager events to be injected to xMatters using web
services, and for the User and Group synchronization process to communicate via web service calls.

The xMatters Web Service User must have the same User ID and Password that you configured within the AlarmPointConfig
script; for more information, see "Modifying the AlarmPointConfig script" on page 10.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To set up a Web Service User:

1. In xMatters, click the Users tab, and then click Add Web Service User.
2. Enter the following information into the form:

e User ID: hpsm-apwsu

Description: HP Service Manager - xMatters Web Service User
e Password: type the User’s password (default is password)
e Verify Password: retype the password to verify it.
3. Add the following web services to the Allowed Web Services list:
e Add Coverage
e Add Device
e Add Group
e Add Team
e Add User
e Delete Coverage
e Delete Device
e Delete Group
e Delete Incident
e Delete Team
e Delete User
o Find Devices
e Find Groups
¢ Find Persons
e Find Who Is On Duty
e List Group Members
e Query Group
e Query User
e Update Coverage
e Update Device
e Update Group
e Update Team
e Update User
4. Click Save.

Note: The User ID and Password for the Web Service User must match the web_service user and web_service password
defined in "Modifying the AlarmPointConfig script” on page 10.

Chapter 2: Installation and Configuration | 19



xMatters (alarmpoint) for HP Service Manager Change Management

2.3.6 Configuring the Subscription Panel

This integration is packaged with an optional Subscription panel which reads certain list values from HP Service Manager
through web services. This feature allows Administrators to change the source of the content supplied for these lists from web
service calls to predefined predicate value lists.

To allow Users to subscribe to specific criteria on injected events, you must configure the Subscription panel. Configuring
the Subscription panel requires the following steps:

= Define the Event Domain predicates

» Define a Subscription Domain

= Configure the Subscription JSP

m Create a Subscription

» Create a fail-safe Group

Note: The Subscription Panel file, SMCMSubscriptionForm.jsp, must be copied to the correct directory during the
integration installation, as described in "Installing the subscription files" on page 7.

Defining Event Domain predicates
The default Subscription panel provided with the integration requires the following Event Domain predicates:

= affected ci

assigned to dept
= category

= coordinator

= impact

= initiator

= phase

m priority

= service

= subcategory

= trigger rule

= urgency

Note: You can also use the following steps to add other predicates that you consider important and which you plan to
add to the integration. For more information, see "Adding new parameters" on page 44.

To define the Event Domain predicates:
1. In xMatters, click the Developer tab.
2. On the Event Domains page, click hp_sm_change.
3. On the Event Domain Details page, in the Predicates section, click Add New.
4. Add the following predicates to the Event Domain:

Event Domain predicates

Predicate Type Important Values Description
affected_ci List Automatically
generated
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Predicate Type Important Values Description

assigned_to_dept Text

category List Manually entered A list of categories that are currently marked as
active in HP Service Manager and may be listed on
a ticket.

For example: CI Group, Default, Hardware,
Unplanned Change, Release Management, etc.

coordinator Text
impact List Yes Manually entered The value of the impact drop-down list on the
change request. By default, the possible values are:
e 1 - Enterprise
e 2 - Site/Dept
e 3 - Multiple Users
e 4 -User
initiator Text
phase List Manually entered A list of phases used in your deployment.
priority List Yes Manually entered The default values are:
e 1 - Critical
e 2 -High
e 3 - Average
e 4-Low
service List Automatically
generated
subcategory List Automatically
generated
trigger rule List Automatically A list of reasons the event was triggered, defined in
generated the AlarmPointEvent script library in HP Service
Manager.
urgency Lsit Yes Manually entered The urgency of the change request. By default, the
possible values are:
e 1 - Critical
o 2- High
e 3 - Average
e 4-Low

For more information on the automatically generated list predicates, see "Configuring the Subscription JSP", below.

Defining a Subscription Domain

The Subscription Domain is the reference point of the optional Subscription panel and allows you to control who can create
Subscriptions, how recipients can respond to Subscription notifications, and which Event Domain predicates can be used to
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create a Subscription. You must create a Subscription Domain before you can create Subscriptions with the new panel.

To create a Subscription Domain:

1. On the Developer tab, in the Developer menu, click Add Subscription Domain.

2. In the Event Domain drop-down list, select hp_sm change, and then click Continue.

3. On the Subscription Domain Details page, in the Name field, type HP Service Manager CM.
4. In the Type of Management drop-down list, select Both.

e By default, Subscriptions are non-FYI (i.e., they support response options). To disable two-way Subscription
notifications, select the One-Way check box.

5. In the Custom Page URL field, enter the following path:
jsp\subscription\hpsmcm\SMCMSubscriptionForm. jsp

6. Click Continue.

7. On the Select Appropriate Response Choices page, click Continue.

8. On the Select Appropriate Predicates page, add all of the predicates to the Applied Predicates list, and then click
Continue.

9. On the Select Roles page, specify the Roles you want to be able to create Subscriptions on the Domain, and then click
Save.

e For default (out-of-box) deployments, the recommended Roles are: Developer, Full Access User, Group
Supervisor, Person Supervisor, Standard User, Subscription Supervisor, and Support User.

Note: For more information about working with Event and Subscription Domains, see the xMatters (alarmpoint) engine
installation and administration guide.

Configuring the Subscription JSP
You can use either of the following methods to populate the predicate list values on the Subscription Panel:

= Manually specify the predicate list values in the web user interface.

= Using web services, query HP Service Manager for possible values, and automatically populate the predicate lists with
the results of the web service call.

Note: Changing Subscriptions by adding or removing Event Domain predicates may cause existing Subscriptions to fail.
For more information about working with Event and Subscription Domains, see the xMatters (alarmpoint) engine
installation and administration guide.

Specifying predicate lists manually

To configure the Subscription panel in a demo mode, using predefined predicate list values, you must modify the
Subscription JSP.

To manually populate the predicate lists:
1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\hpsmcm\SMCMConfig.jsp file
in a text editor.
Set the Boolean variable QUERY_ PREDICATE VALUES to false.
Save and close the JSP file.
In xMatters, click the Developer tab.
On the Event Domains page, click hp_sm_change.

A

On the Event Domain Details page, in the Predicates list, click the name of the predicate for which you want to define
the values.

Chapter 2: Installation and Configuration | 22



xMatters (alarmpoint) for HP Service Manager Change Management

7. Add to the predicate list values, and then click Save.
8. Repeat steps 6 and 7 for each predicate to which you want to assign values.

The predicate lists on the Subscription will now be populated with the predefined list values instead of the web service call
results.

Populating predicate lists automatically

If you want to populate the predicate values lists from HP Service Manager through web service calls rather than the
predefined predicate list values, you must configure the connection properties within the JSP file.

To configure the Subscription JSP to connect through web services:
1. Open the <xMHOME>\webserver\webapps\cocoon\alarmpoint\jsp\subscription\hpsmcm\SMCMConfig.jsp file
in a text editor.
2. Within the Subscription JSP, locate the following section:

final String SERVICE MANAGER URL = "http://localhost:13080/sc62server/ws";
final String SERVICE MANAGER USER = "falcon";
final String SERVICE MANAGER PASSWORD = "";

3. Replace the value within quotes for each parameter as described in the following table:

Subscription JSP parameters

Parameter Value
SERVICE_MANAGER_URL The URL for the HP Service Manager web services.
SERVICE_MANAGER_USER User name of the HP Service Manager Web Services User.

SERVICE_MANAGER_PASSWORD Password for the HP Service Manager Web Services User.

4. Save and close the JSP.

Creating a Subscription

You can now use the custom Subscription Panel to subscribe to HP Service Manager events that match specific criteria. For
example, you could configure a subscription that would send an informational notification to a specific User each time an
event entered the system that was of critical severity. These notifications, and there responses, do not affect the normal
progression of an event through the system.

To create a Subscription:

1. On the Alerts tab, in the Alerts menu, click My Subscribed Alerts.

2. Select the HP Service Manager CM Subscription Domain, and click the Add New link.

3. On the Subscription Details page, specify a name for the Subscription, and set the Subscription criteria using the tabs.
4

. When you are satisfied with the criteria, click Save to create the Subscription.

» The Change Information tab (Ctrl-click to select more than one value):
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Category:

Subcategary:

Priority:

Urgency:

Impact:

Service:

Fhase:

Trigger Rule:

Affected CI:

Assignment Group:
Change Coardinator:

Initiatar:

- AN -- ”~
Cl Graup

Cefault

Hardware

KM Document R

Select Subcategory

- AN --
1 - Critical
2 - High
3 - Average
4 - Low

- ANY -
1 - Critical
2 - High
3- Mverage
4 - Low

- ANY -

1 - Enterprise

2 - Site/Dept

3 - Multiple Users
4 - User

- ANY -

Applications

E-mail Fwebmail (Aftica)
E-mail FwWebmail (Asia)
E-mail i WWebmail (Australia)

- ANY -

Assess

Back Qut

Build and Test
Change Approval

- ANY -
Approval

Select Affected Cls

CONTAINSG v
CONTAINSG v

CONTAINSG v

Ernply Fleid = Any Value
Ermply Flieid = Any alue

Ernpty Flald = Any Value

Save

m The Search Subcategories page; you can use this page to further refine your Subscription by specifying which

Subcategories within the selected Categories you want to include:
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Search Subcategories

To find a list of available subcategories, specify your search criteria, and then click "Get Subcategories™. The
search results will include subcategories within following categories only: CI Group, Default, Hardware, KM
Document.

=N =

Subcategory | CONTAINS w

[ Get Subcategories ]

Awvailable Subcategories:

Selected Subcategories:

Save

m The Preferences tab (defines the Timeframe and Overrides applied to events for Subscription notifications):

Change Information rPreferences |

Timeframe

Start Date: |zo1o0/04/21 *(yyyyfmmja‘d)
Start Time: |00:00 |24 hours |0 |minutes ¥
Timeframe ending the next day at 00:00,
oOn the following davs: [Vlsun Maon Mrue Mwed Mrre Fay Mlsar

Tirme Zone: | US/Pacific w

Overrides

Device Types: (4 Devices Emnail Instant Message Text Dewices Foice Dewices

override User Device [
Timefrarmes:

Ignore Device Delays: [

override Device Severities [ ]
and Use All:

Motification Delay: |0 | awin

Save

= You can review the Subscription details at any time on the Summary tab:
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Summary I/ Change Information r Preferences

Matching Any Event Where
» Category MATCHES (Hardware)
AND
® Trigger Rule MATCHES (Phase Change)

Available: Sun Mon Tue wed Thu Fri Sat 00:00 - 00:00
Using: TEXT_PHOME EMAIL WwOICZE IM TEXT_PAGER

Save

Creating a fail-safe Group

If an event is submitted to xMatters when the fail-safe functionality is enabled, and there is no subscription that matches the
event, xMatters sends the notification to the fail-safe recipient. The fail-safe recipient is typically a Group, but can be
configured as a User.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

To create a fail-safe Group:

1. In xMatters, click the Groups tab.

2. Create a new Group named HP SM FailSafe, with at least one User as a Team member to receive notifications.

For more information about creating Groups and Teams, see the xMatters (alarmpoint) engine user guide.

Note: If you want to use an existing Group or a different Group name, modify the value for the $fail safe group variable
defined in the initial PROCESS script in the xMatters scripts. You can also eliminate notifying any fail-safe Group
by setting $fail safe to disabled.

2.3.7 Creating an Admin Group

If a synchronization error occurs and the send_sync_error notification configuration variable is set to true in the
AlarmPointConfig script, then a notification is sent out to the recipient defined in the default alarmpoint _admin_group
variable in the AlarmPointConfig script. The default value is set to "superadmin".

e If you do not want notifications to be sent out due to synchronization errors, set the send_sync_error notification
variable in the AlarmPointConfig script to false.

Note: If xMatters was installed with non-nmerged admin and root accounts, the value for the default_alarmpoint_admin_
group variable should be changed to "companyadmin".

To configure a HP Service Manager Admin Group, click the Groups tab in xMatters, and create a new Group named SM
Admin, with at least one User as a Team member to receive notifications. Update the default alarmpoint _admin_group
variable in the AlarmPointConfig script with the name of the new Group.

Note that if you have already installed the HP Service Manager Incident Management integration, you do not need to do this
step.

Note: For more information about creating Groups and Teams, see the xMatters (alarmpoint) engine user guide.
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2.4 Configuring Synchronizations

The xMatters (alarmpoint) for HP Service Manager Change Management integration supports one-way synchronization of
Groups (both Assignment and Change groups in HP Service Manager), Teams, Users, Devices and Coverages from HP Service
Manager into xMatters. To enable synchronization and customize it to your business behavior, two configuration files are
provided: AlarmPointSyncConfig.xml and AlarmPointSyncList.xml.

Modify these files according to your desired business behavior; the following sections provide an overview of these files and
their configuration options.

Note: If you have already installed the HP Service Manager Incident Management integration, you do not need to
perform this step.

Synchronization Troubleshooting

When performing a synchronization, open the HP Service Manager messages panel. This allows you to see successful
completion of synchronizations such as modifying Groups, Group memberships, Users, and User Devices. Alternatively, you
can use the Sync Report under the Menu Navigation AlarmPoint entry to determine if any errors occurred after
synchronization.

2.4.1 Synchronization configuration file

The AlarmPointSyncConfig.xml file defines the synchronized values for Groups, Teams, Users, Devices and Coverages.
The file included with the integration has default values to use for each object type, but can be customized to use different
values for a specific instance of an object.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different Users.

Note: If have already installed the HP Service Manager Incident Management integration, you do not need to perform
this step.

Default values

Each default element must specify a value for all possible fields (refer to the following section for a complete list of possible
fields). Each default element must also specify the seedOnly and deletable attributes.

If the seedOnly attribute is true, then that object will only be added to xMatters when it is initially synchronized and will no
longer be updated. If the seedOnly attribute is false, any modifications to the object done in xMatters will be overwritten
when that object is updated in HP Service Manager.

If the deletable attribute is true, then that object will be removed from xMatters when it is deleted from HP Service Manager;
otherwise, it will remain in xMatters indefinitely and must be deleted manually.

The following elements must exist in the AlarmPointSyncConfig.xml file:

o default-user

e default-email

e default-work-phone

e default-home-phone

e default-mobile-phone

o default-assignment-group

e default-change-group
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o default-team
e default-coverage

By default, all objects are deletable and seedOnly except for email, work-phone, home-phone, and mobile-phone, which will
always update in xMatters.

There are three different ways that you can specify a default value to synchronize with xMatters:

1. Set a default value for a field:
o default: the value for this field

For example, the role for the following will be standard user unless it is overridden:

<role default="standard user"/>

2. Use a regular expression to extract a value from a field:
o default: the default value for this field if the regular expression does not match
e field: the column in this table to apply the regular expression
e regex: the regular expression used to extract a value
e index: when you use Groups, this is the index of the Group you want to use (where the first Group is 1)
For example, the area-code for the following will be the first submatch when the \D*(\d {0,3}\D*([0-9]{1}[0-9., -] +)\D*'
regular expression is applied to the contact phone field

<area-code field="contact phone" regex="\D* (\d{0,3})\D*([0-9]{1}[0-9., -1+)\D*" index="1"/>

3. Map a field’s value to a desired value:
o default: the default value to use if there is no match
o map Element: the field attribute specifies the column in the table to match; the value attribute specifies the value
of the field to match on; and, the text of this field is the value to be saved

For example, the language for the following will be English, unless the value of the language column in the record is either
de or fi:

<language default="English">
<map field="language" value="de">German</map>
<map field="language" value="fr">French</map>
</language>

Object-specific values

All object-specific elements will override any default value element and can override the seedOnly and deletable attributes.

default-user Fields

Field Description Possible Values

active Whether this User is active true, false

first-name User’s first name Any string

last-name User’s last name Any string
has-mobile-access Mobile access flag true, false

site User’s Site Valid xMattersSite name
language User’s language Valid xMatters language
timezone User’s time zone Valid xMatters time zone
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Field Description Possible Values

role User’s xMatters Role A comma-delimited list of valid
xMattersRoles.

supervisor User’s xMatterssupervisor Valid xMattersUser target name. If the

supervisor in HP Service Manager is not a
valid User in xMatters, the synchronization
for the User/Group will fail.

has-phone-login

Phone login flag

true, false

phone-login

User’s phone login

Unique string containing only digits

phone-password

User’s phone password

String containing only digits

ldap-domain

User’s web login LDAP domain

Valid xMatters LDAP domain

web-login User’s web login Unique web login

web-password User’s web login password Any string

web-login-type Defines whether the web login is a native NATIVE, LDAP
xMatters login or an LDAP authentication

externally-owned Indicates whether the User is externally- true, false

owned

custom-field-name

The name of the Custom Field in xMatters
that will contain the value of SM userld to
be used by xMatters mobile access login and
notification responses.

Any string. Default is “HP SM Login”

custom-field-value

The value to use in the Custom Field defined
in the custom-field-name field.

Any string

default-email Fields

Field Description Possible Values

name Device name (must match a Device name configured in Valid xMatters email Device
xMatters) name

active Whether this Device is active (i.e., available to receive true, false
notifications.

default Whether this Device should be used as the User’s default true, false
Device

delay Device’s delay setting Integer value (time in

minutes)
externally-owned Indicates whether the Device is externally-owned true, false

priority-threshold

Device’s priority threshold

LOW, MEDIUM, HIGH

user-service-provider-id

ID of the User Service Provider (is ignored if the user-

service-provider-name is present)

Long
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Field

Description

Possible Values

user-service-provider-name

Name of the User Service Provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

address Device’s email address Valid email address
default-work-phone, default-home-phone, and default-mobile-phone Fields

Field Description Possible Values

name Device name (must match a Device name configured in Valid xMatters email Device
xMatters) name

active Whether this Device is active true, false

default Whether this Device should be used as the User’s default true, false
Device

delay Device’s delay setting Integer (time in minutes)

externally-owned

Indicates whether the Device is externally-owned

true, false

priority-threshold

Device’s priority threshold

LOW, MEDIUM, HIGH

user-service-provider-id

ID of the User Service Provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name

Name of the User Service Provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

area-code

Device’s area code

String containing only digits

country-code-override

Device’s county code

Valid two letter country code

extension Device’s extension String containing only digits

number Device’s phone number String matching [0-9]{1}[0-9.,
-+

default-assignment-group and default-change-group Fields

Field Description Possible Values

description Group’s description Any string

timezone Group’s time zone Valid xMatters time zone

site Group’s Site Valid xMatters Site

active Whether this Group is active true, false

allow-duplicates Allow duplicates flag true, false

externally-owned Externally owned flag true, false

observed-by-all Observed by all flag true, false
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Field Description Possible Values
observer Target name of a User to be the Group’s observer Valid xMatters User target name
supervisor Target name of a User to be the Group’s supervisor Valid AlarmPoint User target name

use-default-device Use default Device flag true, false

default-team Fields

Field Description Possible Values

suffix Team name is generated by the Group name and Any string not containing ‘|’
the suffix

description Description for the Team Any string

externally-owned Externally owned flag true, false

reuse Reuse Team flag true, false

rotation-interval Rotation interval (only used if type is ROTATION) Integer value (time in minutes)

rotation-start Rotation start date (only used if type is Date in the format

ROTATION) ‘dd/mm/yyyy h:mm:ss AM/PM’
rotation-unit Rotation units (only used if type is ROTATION) DAYS, MONTHS, WEEKS
type Team type BASIC, EVENT _ROUND_ ROBIN,

ROTATION

Team member type (should leave as PERSON for PERSON, GROUP, TEAM, DEVICE
the integration)

member-type

member-delay Delay between Team members Integer value

member-in-rotation Are Group members in the rotation true, false

default-coverage Fields

Field Description Possible Values

suffix Coverage name is generated by the group name and the Any string not containing '|'
suffix

start-time Start time for this shift Time in the format "hh:mm"

duration-hours Duration of the shift in hours Integer value 0 <= N <= 24

duration-minutes Duration of the shift in minutes (added to duration in Integer value 0 <= N <= 60

hours)
exclude-holidays Exclude holidays flag true, false
sunday Coverage on Sunday true, false
monday Coverage on Monday true, false
tuesday Coverage on Tuesday true, false
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Field Description Possible Values
wednesday Coverage on Wednesday true, false
thursday Coverage on Thursday true, false

friday Coverage on Friday true, false
saturday Coverage on Saturday true, false
recurrence-end-date End date for the coverage Time in the format

dd/mm/yyyy h:mm:ss AM/PM

recurrence-frequency Frequency of the recurrence DAILY, WEEKLY,
MONTHLY
recurrence-interval Interval of the recurrence Integer value
recurrence-no-end-date No end date flag true, false
recurrence-occurences Number of recurrences for this coverage Integer value
recurrence-start-date Start date of the recurrence Time in the format

dd/mm/yyyy h:mm:ss AM/PM

2.4.2 Synchronization list file

The AlarmPointSyncList.xml file is used to define which operators and assignments should be synchronized with
xMatters. The XML file contains a list of user elements with a name attribute matching an operator ID and a list of group
elements containing a name attribute matching an assignment name.

The user and group elements have an action attribute which tells the integration whether you want to include only the user
and group in the list for synchronization and exclude all other users and groups, or whether you want to exclude the user and
group in the list for synchronization and include everyone else. The following is an example of what the file would look like
if you want to synchronize only the TELECOMS assignment and want to synchronize all the operators except for FALCON:
<synclist>
<users action="exclude">
<user name="FALCON"/>
</users>
<groups action="include">
<group name="TELECOMS"/>
</groups>
</synclist>

2.5 Configuring custom forms

This integration includes the following custom HP Service Manager forms:

e Sync Report
e Quick Message
e Who Is On Duty Report.

These forms are used to synchronize HP Service Manager information with xMatters, send messages to Groups and Users, and
determine who is on duty for a specific day.
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2.5.1 Sync Report

The Sync Report can begin full system synchronization and view the last status of objects synchronized with xMatters. The
behavior of the page is as follows:

e Click Show Errors to display all synchronization records that are currently in an error state.

e Click Show All to display all synchronization records.

e Select Sync Now to initiate an attempt to synchronize the entire system.

e Click Filter to display all synchronization records that match the specified filter criteria. These filter fields use the
StartsWith operator.

2.5.2 Quick Message

The Quick Message page is used to send a quick message to a list of groups or operators. All messages from this screen will
contain the following information:
e Operator: the user who initiated this message.

e Reference ID: a field that is meant to help associate this message with an existing change request. This is autofillable
by setting the $G.alarmpoint.quickmessage.incidentId global variable.

o Assignment and Change Groups: a list of groups you want to target with this message.

e Operators: a list of operators you want to target with this message. This is autofillable by setting the
$G.alarmpoint.quickmessage.users global variable.

e Subject: reserved for the subject of the message you want to send to the targeted groups and operators.
e Message: reserved for the message you want to send to the targeted groups and operators.
You should now be able to open the Update Change form and see the Quick Message button. This allows you to send a

quick message to a user with the change request ID auto-populated for the selected change request, as illustrated by the
following figure:

[ 88 cancel £ Prev 0 Mext [ Save &Exit [F] Save 5 ClosePhase [ Apply Template Quick Message Halt AlarmPaint Motifications Bl

b
-
PR S
rChange Details
Change ID |c1uuu1 | Assignment: Group |'ofﬁce Supplies (Morth America) ||-P|
Phase [Change Review Change Coordinatar [Rachel Boudreau =+
Status [initial Initiated by [ARMSTRONG, TRACY =

Approval Status | approved |

Service [Printing (Marth America) ||-P| Category |Hardware
Affected CI

adv-nam-printer-hr-5550 Subcategory [Instal Hardware | =

O Emergency Change

D Release Management

a e
Location | ||_P| Impack |'4 - User |v|
Urgency |'3 - fverage | - |
Requested End Date [07/09(15 10:21:00 - Priority [3- Average
Alert Stage & Risk Assesment 3 - Moderate Risk [~
Planned Start =
Planned End — Ext. Project Ref, |

Scheduled Downtime Start | - | -
| | _'IJ
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2.5.3 Who Is On Duty Report

The Who Is On Duty Report is a method of determining who is on duty for a Group for a specified day. The behavior of this
page is as follows:

e The Assignment Group and Change Group selector controls whether Assignment or Change Groups will be shown in
the Group field.

e The Group field is used to select the Group for which you want to run the report. Based on the selected radio button,
you can list Assignment Groups or Change Groups.

e The Start Date field is used to select the day on which you would like to run. This report always generates data for
only a single day.

e Clicking Check makes the request to the server and displays the results in the HTML window at the bottom of the
page.

o The Recipients list is automatically populated with the Group name, Group member names, and the Group Supervisor
names. Clicking Send Message on this page will take you to the Quick Message page and auto-populate the Operators
field with the selected Recipient.

Note: The Who Is On Duty Report is available only to xMatters enterprise customers.

2.5.4 Adding buttons and Menus for custom forms

The alarmpoint.syncreport, alarmpoint.quickmessage and alarmpoint.whoisonduty scripts are provided with the
integration and can be used with the script.execute RAD application. If you set the global variables $G_alarmpoint
quickmessage incidentIdor $G_alarmpoint quickmessage users before running the alarmpoint.quickmessage
script, the incident ID and operators fields can be automatically populated with data.

To add Custom Form menu items:

1. In Service Manager, open Menu Navigation > Tailoring > Tailoring Tools > Menus.

2. In the Menu Name field, type the name of the appropriate menu for your deployment (e.g., HOME), and then click
Search.

3. Add the following values to the table:

Option Number Description Application Parameter Value Condition
Next available xMatters menu.manager name AlarmPoint MAIN index("AlarmPoint",
number $lo.ucapex)>0

Note: Ensure that you record the Option Number assigned to each button and menu, as you will need to reference these
numbers when adding the custom form buttons in the next section.

4. Click Save, and then click Save again.
o Ifyou receive an error message after clicking Save the first time, you can safely ignore it.
5. Refresh the System Navigator.

You should now see a new xMatters navigation group in the System Navigator with separate entries for each custom form.

Note: The buttons and menu items are visible only to users with the "AlarmPoint" capability. For information about how
to add the capability, refer to "Adding capabilities to users" on page 12.

The integration also installs a display option control, with a unique id of alarmpoint.apm.edit.problem.haltincident, labelled
Halt AlarmPoint Notifications. Users should be able to open the Update Incident form and have the Halt AlarmPoint
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Notifications control available allowing you to halt all xMatters notifications for that incident. Note that the default Balloon
Help value for alarmpoint.apm.edit.problem.haltincident is 200, but this can be changed if your Service Manager installation
already has a display option associated with apm.edit.problem that uses a value of 200.
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Chapter 3: Integration Validation

After configuring xMatters and HP Service Manager, you can validate that communication is properly configured. It
is recommended that you start the components in the following order:

e HP Service Manager Change Management

e xMatters (alarmpoint) engine

e xMatters integration agent
Consult the respective user manuals for details on starting these applications.

The following sections will test the combination of xMatters and HP Service Manager for notification delivery and
response, Subscription Panel functionality, and synchronization configuration. This section also includes an
explanation and demonstration of how to query HP Service Manager via the mobile access component using a
BlackBerry.

3.1 Validating User and Group Synchronization

The following validates that communication from HP Service Manager to xMatters for User and Group
Synchronization is properly configured.

Note that the User and Group synchronization process is handled via direct web service calls between xMatters and
HP Service Manager; synchronization relies upon the correct configuration of the web services user, as described in
"Adding the Web Service User" on page 19

Note: For this example, it is recommended that you set the Email Device’s User Service Provider to use virtual
email. This will help when troubleshooting problems in later testing.

To test the User and Group Synchronization:

1. Edit the <SMHOME>\AlarmPointSyncList.xml file as follows:

<synclist>
<users action="include">
</users>
<groups action="include">
</groups>
</synclist>
2. Restart your HP Service Manager client.
3. Add a new Operator to HP Service Manager:
e In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance >
User Quick Add Utility.
o Specify the required information.
e Click Next, Finish, and then OK.
4. In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance > Groups
> Incident Management Assignment Groups.
Type the name of the assignment group you want to use for testing purposes (eg. TESTSYNC).
Select the Operators tab, add the Operator you just created, click Add, and then click OK.
7. Edit the AlarmPointSycnList.xml file to look like the following (replace operatorname and
assignmentname with the Operator and Assignment Group you just created):

<synclist>
<users action="include">
<user name="operatorname"/>
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</users>
<groups action="include">
<group name="assignmentname"/>
</groups>
</synclist>
8. Restart the Service Manager client
9. Open the custom Sync Report form (see "Adding buttons and Menus for custom forms" on page 34 for instructions how
to add a menu item for this).
10. In the drop-down list in the upper right, select Sync Now.
o This should synchronize the operator and assignment that you just added to HP Service Manager into xMatters as
a User and Group.

11. Log in to xMatters to check that the User and Group was properly synchronized.

Note: The xMatters User target name is the HP Service Manager contact’s operator ID and the xMatters Group name is
the HP Service Manager assignments name.

3.2 Triggering a notification

In this example, an event will be injected to xMatters for notification to the Group configured in the User and Group
Synchronization example.

1. In Service Manager, open Menu Navigation > Change Management > Changes > Open New Change.
2. Specify the following values in the required fields:
o Impact Assessment: cither 1- Enterprise or 2 - Site/Dept.
e Urgency: either 1 - Critical, or 2 - High.
3. Enter values for all other required fields.
4. Click Submit.

This should inject the change request parameters into xMatters, triggering a new notification targeting the group you just
synchronized with xMatters in the User and Group Synchronization example.

3.3 Responding to a notification

This section describes how to respond to a notification from xMatters. In the following example, the notification is received
on a BlackBerry Device, but the process is similar for all Devices.

To respond to a notification:

1. When a notification arrives for the User, the Device indicates the number of calls received:
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3. Scrolling down will display the remainder of the details, and the list of possible replies:
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4. To respond to the notification, the User clicks a response choice, and xMatters updates the change request in HP
Service Manager.

For more information about response choices, and changing the options available to Users, see "Response choices" on page

44,

3.4 Viewing response results

When an action is taken on an xMatters notification, that action is reflected in the original change request. When xMatters
makes changes to a ticket, it also updates the Historic Activities field on the change request.

To view the notification results:

1. In Service Manager, open Menu Navigation > Change Management > Changes > Open New Change.

2. In the Number field, type the ID of the change request you want to view, and then click Search.
3. Click the Activities tab, and then click the Historic Activities tab to view the updates:

% Update | $ Historic Activities |

Filter By Activity Type:

[=]| e |

Drate, Time I Tvpe I Operator | Descripkion

5043'239'10 13:03:45 AlarmPoink fFalcon Successful Delivery For Change Coordinator (Change. Coordinator | wWork BES),
04/23010 13:08:55 AlarmPoint falcon Successiul Delivery For Change Coordinator (Change. Coordinator | wwork Email),
0423010 14:22;58 AlarmPoint Change Coordinator | Approved by Change Coordinator (Change, Coordinator|Work BES)

Q423010 142309 AlarmPoink fFalcon Successful Delivery For Change Approver (Change, dpprover |\Wark Email).
04/23(10 14:23:10 AlarmPoint falcon Successful Delivery For Change Approver {Change. Approver|Work BES).
0423010 13:08:25 Fhase Change falcan "Prepare for Change Approval” to "Change Approval”

04023010 130752 Phase Change fFalcon "Prepare For Change Approval” to "Change Approval®

0423010 13:07:45 Phase Change falcon "Change Assessment & Planning” to "Prepare for Change Approval”

0423010 13:07:35 Fhase Change falcan "Change Review" to "Change Assessment & Flanning”

042310130727 Phase Change Falcon "Zhange Logaging” bo "Change Review"

04/23/10 13:06:54 Open fFalcan Test Motification Responses
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For each User Device notified during this process, the Journal Updates log will be annotated with a message indicating
“Successful Delivery for bsmith|Work Email” where “bsmith|Work Email” is the recipient (<User>|<Device>).

3.5 Testing the Subscription Panel

To test Subscriptions, ensure that you have created a Subscription (for more information, see "Creating a Subscription" on
page 23). Trigger a notification that matches the criteria that you have configured your Subscription to match. You will
receive an FYI Notification (informational only) which will not have any response choices available.

Note: Ensure that Subscriptions are enabled in the Action Scripts with the $enable subs variable. For more information
on how to configure Subscriptions, see .

3.6 Querying for an event

This section describes how to validate that the mobile access component, integration agent and HP Service Manager are
properly configured.

Note:  The xMatters mobile access page has a default URL of http://<xMattersIP>:8888/mg, where <xMattersIP> is
the IP address of the xMatters web server where the mobile access component is configured.

To query for an incident:
1. Using a browser-enabled smart phone (such as a BlackBerry), open a browser and navigate to the mobile access
component URL.

2. Log in to the mobile access component:

matters

XMatters Moblle Gateway Login
Username: _I}sr'nll:h

Password: |[eses

3. If more than one Integration Service is available, select the hpsmem service.

4. If prompted, enter the HP Service Manager login credentials, and then select the Open Changes menu item:

x xMatters mobile access =

http://192.168.170.221:888... [NEEY

HP SM Change Menu matters

[51] Higk
[{J'I.] juf: hanges
[6] My

Chapter 3: Integration Validation | 40



xMatters (alarmpoint) for HP Service Manager Change Management

5. View the list of all open change requests:

x xMatters mo

List Changes [51]

approved Unblock websites
G| approved EIhY| Virus e-mall

approved IELE Mew network card
) || approved [GIELE| Multiple vinesses

Allow bigger mails
approved e

ir af
approved LG Operating system
reinstal

pending SPAM filter

- Relnstall network
approvied Eali]
pu drivers

' | approved m SPAM filter

Metwork drivers

Status - || go matters
ICTO05E - MalT Server Outage
Change ID: C10068

Phase: Change Review
Status: Initial

Approval

Status: Pen9Iind
Title: Mall Server Outage

Mall Server not working

Description
P potentially due to power outage

7. To view the available options for the change request, click the drop-down list at the top of the screen:
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~ Status

Details

Detail Dates
Contact Details
Affected Cl
Approvals

Add Activity

Activities

8. To view the Approval status of the change request and, if required to respond, Approve or Deny the change request,
click the Approvals option:

Approval Status: pending

Current Sequence: 1

Approvals v | g0 matters
Currently Pending Approvals
CI004T - TES CI10049]1

Approval Type: bsmithapproval Grp/Oper

Requested By: BUCKLE, EMILY bsmith
Approval Status: pending
Current Sequence: 1 Future Approvals

seqlarp/oper

Currently Pending Approvals

bsmith Completed Approval Actions

T e
Future Approvals
m Approve @ Deny

9. Click Approve to approve the change request and then provide a reason for the decision:
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Add Activity * go matters

TOUST - TES CI009T
Please enter a reason for the approval.

) Zudget Approved
Add Activity:

_55'!’_';]";‘;*_-

10. Click Approve again to send the action to HP Service Manager.

e The mobile access component screen displays the Activites screen, showing the reason for the approval:

Activities v || go matters

g1 - TES CIUINT

Change C10041 Phase Change Review
Updated by bsmith.

Change C10041 Phase Change Review
Approved by Bob Smith.
Change C10041 Phase Change Review
AFI:I:II‘O\I’E*h',' bsmiith.

The Approval Status has been set to
approved. No other groups are pending
approval.

o Activitles
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Chapter 4: Optimizing and Extending the Integration

This section describes some of the available methods you can use to optimize or extend the xMatters (alarmpoint)
for HP Service Manager Change Management integration.

4.1 Adding new parameters

Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP Service Manager. The
following steps explain how to add a new event token to the event injected to xMatters.

To add an event token:

1. In HP Service Manager, click Menu Navigation > Tailoring > Script Library.
2. In the Name field type AlarmPointCMEvent, and then click Search.

3. Find the addEvent function.
4

. After the other lines starting with addEventTokenToRequest, add the following (where “TokenName” is the
name of the token and “tokenvalue” is the value for the token):

addEventTokenToRequest (request, "TokenName", tokenvalue);

5. Click Save.

4.1.1 Adding new tokens to notification content

Once you have injected the new data elements, you can add the token as a parameter to the notification content for
Devices. The following steps explain how to add the custom parameter to email notifications; adding content for
other Device types is similar and requires the presentation script to be modified for the specific Devices.

To add a new token to email notification content:

1. Open the xMatters Developer IDE and check out the HP Service Manager Change Management (BUSINESS)
Script Package.

2. In the Presentation Action Script, add the following line to the email content creation section:

Scontent.message = S$content.message & "TokenName: " & S$event.tokenvalue & "\n"

3. You can also add a check in the Initial script to confirm that the custom parameter was injected properly and
exists within the Action Scripts:
IF ( ! EXISTS( $Sevent. tokenvalue ) )
$event. tokenvalue = Sundefined default
IF ( $main.debug )
@script::log( $main.log prepend & "Optional token ' tokenvalue '
not found, defaulting to '" & $event. tokenvalue & "'" )
ENDIF
ENDIF

Your custom parameter should now appear in your notification content for email Devices.

4.2 Response choices

This integration allows recipients to respond to notifications with several default choices, some of which are
injected back to the HP Service Manager server, updating the original change request. Users notified on email
Devices also have the ability to respond with an extra annotation message which will be logged in the original HP
Service Manager change request.
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The following is a list of the default response choices available with the integration and their associated actions on the
xMatters event and the change request.

Default response choices

Response xMatters Action HP Service Manager Update Availability
Approve Signifies that the User approves the The approval record for the change All non-FYT devices
change request, and delinks all Users request is updated with the Approve
from the change request. response. The response and any
additional notes added to the
response are recorded in the change
request's Activities tab.
Deny Signifies that the User denies the The approval record for the change All non-FYT devices
change request, and delinks all Users request is updated with the Deny
from the change request. response. The response and any
additional notes added to the
response are recorded in the change
request's Activities tab.
Annotate Halts delivery of notifications to any  Any additional notes added to the This functionality is

available for Email
Devices only.

other Devices the responding User
may have configured.

response are recorded on the change
request’s Journal Updates.

4.2.1 Adding annotation messages

Two-way email Device notifications (not FYI) can add extra annotations that will be added to the change request as a
message on the Journal Updates tab. To add an extra annotation, respond to an email notification with the following format
in the subject line:

RESPONSE <Choice> <Message>
<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add

as the annotation.

4.2.2 Responses for sync errors and quick messages

Sync Error and Quick Message notifications are based on the hp_sm_change Event Domain. These create an event within
xMatters and the available responses do not have any effect on the HP Service Manager system.

4.2.3

4.2.4 Responses for FYI notifications

FYI notifications do not have any response choices available, except for FYI notifications sent to voice Devices. Voice FYI
notifications offer the following response choices so that Users can navigate between multiple notifications. (This navigation
is not required on other Devices.)

Voice Device responses for FYI notifications

Response Description

Delete Removes the notification from the User’s list. This option is most likely to be selected.
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Response Description

Save Saves the notification and stops attempting to deliver it to the User’s other Devices. Users may select this
option to delay listening to the notification when it is delivered, and access the details by calling in, or via
the xMatters web user interface, at a later time.

Repeat Replays the notification content.

4.2 Annotations

This integration extensively annotates the originating HP Service Manager change request, but this may not be desirable in
all environments. To prevent the annotation of change requests, you will need to edit the action scripts.

All annotations are prefaced by a comment indicating that the following call is an annotation:

# Annotate SM Event

ééérviceimanagerimessage = $message note

éééUB annotateChange
To prevent the annotation of change requests, replace $service manager message = $message note with $service
manager message = "'".

For additional annotations, add the following section of code where $message note is the message to be annotated:

# Annotate SM Event

$service manager status = ""

$service manager message = S$message note
GOSUB annotateChange

4.3 FYI Notifications

You can make all notifications informational only (i.e., the user is not offered any response choices). Setting the $force fyi
flag to "on" makes all normal and Subscription notifications one-way (FYT).

In the initial PROCESS script, locate the following line:

S$force fyi = disable

Change the line to:

$force fyi = on

Note: All FYI events are set to priority LOW; this allows users to prevent the alerts from being sent to specific Devices by
configuring their Devices to be used for only Medium and High priority alerts.

4.3.1 Generating FYI notifications for Subscriptions

When using subscriptions to inform Users about service outages, you may want to remove responses from notifications
generated for subscriptions.

To accomplish this, select the One Way check box on the Subscription Domain details page for the associated Subscription
Domain.

4.4 Adding custom trigger rules

To add a custom trigger rule that will trigger a notification to be injected into xMatters:
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Click Menu Navigation > Tailoring > Script Library.
Type AlarmPointCMEvent in the Name field

Click Search.

Modify the following methods to suit your requirements:

r oW N~

o getTriggerRule() - This method is used to determine whether a notification should be injected into xMatters.
o getDeviceFilter() - This method is used to return a device filter string that will limit the Devices to which that
notification will be sent.

For example, the default behavior is to inject a notification into xMatters upon change creation. To modify this to only inject
a notification on creation when the urgency is either critical or high, change the following lines:

else{
triggerRule = "Creation";
}
To:
else{
if (record.severity <= 2)
triggerRule = "Creation";

4.5 Altering the duration of events

You can modify the amount of time xMatters will send out notifications for a particular event before it times out by changing
the $main.timeout variable in the initial process script. This variable stores the number of seconds the notifications will be
allowed to continue before timing out.

For example, if you wanted to change the event duration to two hours, you could change the variable to:

Smain.timeout = 7200

4.6 Optimizing the mobile access component

This section describes some of the ways you can optimize or extend the xMatters mobile access portion of the xMatters
(alarmpoint) for HP Service Manager Change Management integration.

4.6.1 Add a custom query to the home page

To add a custom query and link to the home page, add the following to the <xMHOME>\webservices\webapps\
mobilegateway\jsp\hpsmcm\configuration.jsp file installed on the mobile access component:

MAIN MENU OPTIONS.put ("Query Label", "Query");

For more information about constructing queries for HP Service Manager, consult the HP Service Manager documentation.

4.6.2 Creating a URL alias

The urlalias.jsp page in the mobile access component is used to drive directly from an xMatters notification to the Create
Incident or Update Incident screens. It supports the following parameters:

urlAlias.jsp parameters

Name Description

changeID The ID number of the change request to update. This field must be set to a valid change request ID number.

Field The name of an API Caption of a field for the change request. For each parameter set, it will update the field on
Name the incident with that value.
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Note: For more information about the urliAlias method in the xMatters Action Script, refer to the xMatters Online
Developer's Guide.

4.6.3 Exposing a new field

The following steps explain how to configure a new field that has been exposed in the HP Service Manager extaccess record
to be displayed on the xMatters mobile access.

Note: In the following steps, replace "Field Name" with the API caption name of the new field exposed in HP Service
Manager.

To expose a new field:
1. Expose the new field in the HP Service Manager extaccess record as descibed in "Exposing additional fields for
existing web services" on page 12.

2. In the <xMHOME>\webserver\webapps\mobilegateway\jsp\servicemanager\includes folder, add the following
line to the initialize.jsp and initializeOldChange.jsp files:

newFields.put ("Field Name", "");
3. To display the field on the New Change screen, add the following to the createFields.jsp file; to display the field
on the Update Change screen, add the following to the updateFields.7sp file:

fields.put ("Field Name", "Field Label");
fieldTypes.put ("Field Name", "Field Type"):;

Field Name The API caption name for the field exposed within HP Service Manager.

Field Label The name that will appear within the mobile access component representing the exposed HP Service
Manager field.
Field Type The type of field exposed (as defined in the table below).

4. If the field is a required field, add the following:

requiredFields.add ("Field Name");

Field Type Description

Text Displays the value of this field in an editable text input if there is a single value, or in a text area if there
are multiple values.

ReadOnly The value of this field will be displayed as plain text with no inputs

WriteOnly The value of this field will not be displayed, but a text input will be displayed for a single value or a text
area if there are multiple values, and both will allow input.

List If a list is defined, a drop-down list will be displayed for this field; otherwise, a text input field will be
displayed.

Defining List Field Values

To define the values for a list field you must add the following to the
<IAHOME>/integrationservices/hpsmcm/hpsmecm. js file:

fields.put ("Field Name", client.getSortedList ("SoapAction", "Query", "Field"));
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Where:

e SoapAction is the SOAP Action defined by the HP Service Manager web services; for example,
“RetrieveCategoryListRequest”.

e Query is the query used to return a list of values.

e Field is the name of the API Caption defined in HP Service Manager.

Defining Static List Values

To define the values for a static list, you must add the following to the
<xMHOME>/webserver/webapps/mobilegateway/jsp/hpsmem/includes/initialize. jsp file:

incident.addList ("Field Name", Arrays.asList(new String[]{ "Value 1", "Value 2", ... }));

4.7 Constructing BES and email notifications

You can configure xMatters to create BES and HTML email notifications.

This feature requires the xMatters Developer IDE. For installation instructions, refer to the xMatters Online Developer's
Guide.

To enable BES and HTML email, the HP Service Manager Change Management (Business) script package set must be
checked into the xMatters Developer IDE database. If the script package has not been checked in already, see the instructions
in "Importing the script package" on page 16.

Note: Some email clients, such as Microsoft Outlook 2007, may not display HTML elements correctly. It is recommended
that you test the HTML compatibility of your email client before implementing the HTML email feature.

To enable BES and/or HTML email:

1. Launch the xMatters Developer IDE.
2. Check out the HP Service Manager Change Management (Business) Production script package.
3. In the Global Configuration Variables section of the initial PROCESS script, do the following:

e Set the Smain.enable HTML Email variable to true.

e Set $main.use logo to true if you want your HTML email to show a logo.

e Set $AlarmPoint URL to the base URL of your xMatters web server. (default is localhost).
4. Optionally, you can also do any of the following:

e Change $main.HTML form url to point to a JSP page that you want to process any responses from the HTML
email. (the default setting should work out-of-the-box).

e Change $main.logo to a URL that holds the image you want to display at the top of HTML emails (by default,
it points to the xMatters logo).

e Set $Smain.logo alt text to the text you wish to display when the logo cannot be fetched. This can be
displayed if the email client is configured not to show images, or it could be displayed because the email client
cannot access the xMatters web server directly and thus cannot respond by using the links in the HTML.

e If you are using BES and have access to a BES server, you can set the URL to the BES server in the $main.bes
pushurl variable.

5. Save and validate the script, and check in the script package.

For more information about these and other configuration variables, see “Configuration Variable Reference” on page 55.
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4.8 HP Service Manager logging

All of the integration actions and errors are printed out to the messages panel and logged to the standard HP Service Manager
log file specified in the sm.ini configuration file. These messages are defined in the AlarmPointUtil script library and are in
the following format:

",
’

oe

o

S
o

var RECIPIENT UPDATE FAIL = "Failed updating AlarmPoint %% 3%

Messages are displayed using the following function:
logMessage (messageld, <args>)

where messageId matches the variable used to define the message and <args> is replaced by as many arguments as you
want. These extra arguments are used in order to replace all occurrences of %% in the defined message.

For example, to log the message ‘Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN_ GROUP’, you would use
the following:

logMessage ("RECIPIENT UPDATE FAIL", "Team", "TELECOMS-24x7", "UNKNOWN GROUP");

This would print in the Service Manager log file as:

3204 ( 2656) 12/04/2007 11:15:26 JS I Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN
GROUP

4.8 Uninstalling

For instructions on removing an xMatters deployment, refer to the xMatters (alarmpoint) engine installation and
administration guide.
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Chapter 5: Configuration Variable Reference

This section outlines and describes the configuration variables available in the initial PROCESS Action Script.

5.1 Global configuration variables

These variables are available throughout the script package, and are parameters of the “main” object. The value
assigned to each variable is its default value within the script.

Gobal variables

Variable Description

$main.timeout = 86400 Amount of time (in seconds) the event is allowed to run
before timing out. (86400 seconds = 24 hours.)

$main.debug = false Indicates whether to log informational messages for
debugging purposes. Disabling this variable may improve
performance, but will provide less information.

$main.use_logFile = false Specify whether to use an alternate log file for debugging
messages. This variable is ignored unless $main.debug is
also set to true.

$main.logFile = "../logs/" Defines the file used to log debugging information (only
if $main.use_logfile is set to true).

$main.maxInvalidResponses = 3 Specifies the maximum number of invalid responses
allowed before the notification will no longer be
requeued. If a recipient sends an invalid response and this
number has not been exceeded, they will be renotified
with the same content, prefixed with a message indicating
that their response was invalid.

$main.annotate = true Enables submission of information back to the
Management System.

Information is logged throughout the script progress; if
this variable is set to true, these logged messages will be
annotated to the originating event. Setting this variable to
false may improve performance, but will make debugging
difficult as some information may not be annotated to the
originating event.

$main.subscription_annotate = false Enables submission of Subscription information back to
the Management System. (As with $main.annotate, but
specifically for Subscription information.)

Most Subscriptions are informational only; this variable
can be enabled, for debugging and informational purposes
but may reduce performance.

$main.enable. HTML_Email = true Enables HTML Email functionality for email clients able
to support HTML emails. If a client cannot support HTML
than the plain text version will be passed.
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Variable

Description

$main.xMatters_ URL = "http://localhost:8888"

Identifies the xMatters URL used for the HTML response
form and xMatters logo. If the specified URL cannot be
reached, the logo will not appear, and the response links
will not work.

Smain.HTML_form_url = $xMatters URL &
"/jsp/ProcessNotificationResponse.jsp"

Specifies the URL of the xMatters web server’s Process
Notification Response JSP form, used by HTML email and
BES to inject responses through the system.

$main.use_logo = true

Specifies whether HTML email notifications will display
the xMatters (or custom) logo.

$mainlogo = $xMatters URL &
""/static/images/logos/alarmpoint/ UNKNOWN.png"

Specifies the path to the graphic displayed on HTML
(email and BES) notifications.

$main.logo_alt text = “[If the logo does not appear
you may be blocking images or you may be outside
a firewall. If the latter, the links will not work for
responding and you should respond by replying to
this email as described below.]”

The alterate text to display if the HTML email logo is
unavailable.

Note: If the logo does not display, it is unlikely that the
HTML form url is valid and responses will not be
injected from HTML Devices (email and BES).

$main.numeric_pager_number = “555-1212”

The phone number to display for calling in to retrieve
event information. This variable has a non-existent
number as a default value; a real call-in number must be
supplied, or a message indicating that an xMatters event
has occurred.

$main.bes_pushurl = “http://localhost:8888/static”

Specifies the URL of the BES server. (Optional.)

S$Smain.use_default credentials = false

Determines whether to use the User's custom credentials
(the contents of the HP SM Login and HP SM Password
custom fields) or the default HP Service Manager
credentials when interacting with HP Service Manager;
i.e., for annotating responses.

$main.servicemanager _username = ''falcon"

$main.servicemanager_password = """

Specifies the default HP Service Manager login
credentials to use when a User has not specified values for
the custom fields.

$Smain.servicemanager username_custom_field =
"HP SM Login"
$main.servicemanager_password_custom_field =
""HP SM Password"

Specifies the names of the custom fields that store the user
name and password for each user accessing HP Service
Manager.

5.2 Local configuration Variable

These variables are available only in this script, and control how the script runs. For more information about the initial
PROCESS script, consult the xMatters Online Developer's Guide.
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5.2.1 FYI and Subscription notification variables

The following variables configure the behavior of informational-only, or FYL, notifications. The value assigned to each
variable is the default value within the script.

Note: For more information on the behavior associated with informational-only notifications, see "FYI Notifications" on

page 46.
FYl and Subscription variables
Variable Description
$force fyi = “disable” Forces notifications to be informational only rather than requiring responses.
Possible values are:
e disable: nothing is forced.
e on: notifications are forced to be FYL
¢ off: notifications are forced not to be FYI.
Suse_email_for_fyi = true Configure Device filters for informational-only (FYI) notifications.
Suse_phone_for_fyi = false Setting these flags to false prevents that Device type from being notified with

$use_im_for_fyi = true informational (FYI) messages.

Suse_text_phone_for_fyi = true
Suse_text_pager_for_fyi = true
Suse_numeric_pager_for_fyi = true
Suse_bes_for_fyi = true

Suse_generic_for_fyi = true

5.2.2 Fail-safe configuration variables

The following variables configure the fail-safe functionality, and specify when notifications will be sent to the fail-safe
recipient. The value assigned to each variable is its default value within the script.

Note:  For instructions on how to set up a fail-safe recipient, see "Creating a fail-safe Group" on page 26.

Fail-safe variables

Variable Description

$fail_safe = “enabled” Controls whether the fail-safe recipient is notified, and under which
circumstances. Possible values are:

¢ enabled: notify the fail-safe Group if no Subscriptions match and there are
no notifiable recipients.

o for-subscriptions: notify if the Subscription functionality is enabled and
no Subscriptions match.

o for-recipients: notify if there are no notifiable recipients.

o disabled: disable the fail-safe functionality; no notifications will be sent
to the fail-safe recipient.

$fail_safe group = "HP SM FailSafe"  Identifies the fail-safe recipient, which is typically a Group, but may be a User.
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5.2.3 Notification configuration variables

The following variables configure notification behavior. The value assigned to each variable is its default value within the
script.

Notification variables

Variables Description

Soverride timeframes = false Overrides any Device Timeframes that have been configured for a User for this
notification.

Suse_emergency_devices = false Forces the use of emergency Devices as part of the Device resolution processing.

Strack_delivery = true Configures the notification to run a response script when the delivery of a

notification is successful. As this can limit Node performance, you can set this
value to false if the custom behavior for successful delivery events is
unnecessary, but you will lose any information about whether a delivery was
successful.

5.2.4 xMatters integration agent configuration variables

The <IAHOME>\integrationservices\hpsmcm\hpsmcm.js file installed on the Integration Agent contains the following
configuration variables:

xMatters integration agent variables

Variable Description

smUrl = “http://localhost:13080/sc62server/ws” Defines the URL of the HP Service Manager web services

calloutAnnotateUser = "falcon"; These variables must be updated to specify a valid user name and
password combination that has permissions to add journal entries to

calloutAnnotatePass = ""'; .
change request tickets.

The values are only used for Callout Annotations from the CALLOUT
APS script.

5.3 xMatters mobile access configuration variables

The <xMHOME>\webserver\webapps\mobilegateway\jsp\hpsmcm\configuration.jsp file installed for the mobile
access component contains the following configuration variables:

xMatters mobile access variables

Variable Type Description Default Value

MAIN_MENU_COUNTS Boolean  Enables the queries on the home page to be run true
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Variable Type Description Default Value
MAIN_MENU_OPTIONS map Defines what queries should be displayed on the High Priority
homepage Incidents

Open Incidents
Assigned To Me

Hot Incidents

Unassigned
Incidents
PAGINATE_RESULTS boolean  Enables pagination of the change requests lists true
RESULTS PER_PAGE int Defines how many results should be displayed on each 10
page of the change requests lists
USER_NAME_FIELD string Defines the name of the custom field in xMatters "HP SM Login"
containing the HP Service Manager login user name
PASSWORD_FIELD string Defines the name of the custom field in xMatters "HP SM

containing the HP Service Manager login user password Password"

VERIFY_CREDS boolean  Enables the validation of entered HP Service Manager  true
login credentials when loading the mobile access
component homepage

LISTS_EXPIRED long Defines how long to cache list values retrieved from HP 3600000
Service Manager through web service calls
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